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1 7= kiR
11 PRI

M2 PM-127 28 T £ HF1 PROFIBUS DP il f5 . wi&EH: 2 AN 2 A5 Modbus RTU/ASCII (RS485)
B4 % 2] PROFIBUS DP, [l Modbus/RS485 [ 2% 14 #5141 ) PROFIBUS DP %45 14 4% .

1.2 PR R

VR : LA RS485 2111 Modbus RTU/ASCIL i B 46 1l LAAE FTAS 7= it S 9L 5 B 3 i 2
PROFIBUS {1 Hi%. Wi: HA7 Modbus Pristas A% . AR SRS E . RS IR Hgs . sl
B P ASIE RS BRI IR A B AR

VR B P AN T A PROFIBUS F1 Modbus BRI, 17 U S 25 AT A B A (1 S FH s, ARG
FORSERACE , AT gnfE, [ n] eI (R Py S I Bl A

VEHEG: ol LUK PROFIBUS A5 £ X il Modbus 18 {75 204 X LGS G R, SEIL PROFIBUS %)
Modbus - [ ) 445 17 W8 155 .

1.3 BiARTER

[1] PM-127 M &7E PROFIBUS {ill /&£ —/> PROFIBUS DP A%, 7 Modbus —fil] /& Modbus =, M3in] i%; il
PROFIBUS i {5 #4l X A1 Modbus #4 <. () £ 5 53 PROFIBUS A1 Modbus #4832 W5
[2] PM-127 WA Modbus T3, % FF 01H. 02H. 03H. 04H. 05H. 06H. OFH. 10H SIhfitfid; B[
Fit & 48 %4 Modbus #r4;
[3] PM-127 M 5AE 4 Modbus M3, SZHF Modbus 27 /7 # itk 3 X (3xxxx). 4 X (4xxxx). 0 [X (0xxxx) Al
1IX (Ixxxx)s b, 3 XSCRFLIAERY 04H; 4 XSZHFI)RERS 03H. 06H. 10H: 0 XSZHFI)HEM 01H. O5H.
OFH; 1 XSZFFDIRERS 02H;
[4] PROFIBUS DP/VO B3, 545 JB/T 10308.3-2001: il & A4 il % = £ il A5 Tk KRG H IL% 2658 3
#43>: PROFIBUS #iil;
[5] PROFIBUS DP M, PR3 HOEN, SCRPIRFZRTE . 9600~12Mbps;
[6] PROFIBUS %t A\ /4t 7 5 ¥l it Step7 A ¥ 5E, fix kK PROFIBUS #i A\ /4t -

(DMax Input Bytes <244Bytes

(2Max Output Bytes <244 Bytes
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(3Max Data Bytes <488 Bytes

[7] #=HIshAgE: 14 Modbus 3%, PROFIBUS i i] L fe ¥4 Fl124 1 Modbus i ) % 3%

[8] KA WAL LIRE - 1124 Modbus 23, PROFIBUS iy 1] LA # Modbus s 4-IR7 ; /£ 5 Modbus Ml , PROFIBUS
Ui 7] LA Modbus 9 Z81R 245

[9] Modbus Pl 1 & RS-485 #£11, XU T; 4% 300, 600, 1200, 2400, 4800, 9600, 19200, 38400,
57600, 115200bps AJ3k; 8 fr Al ; HIGAL(R. 7. o Anids M) AaE; 5 ibAr (1. 2) wik;

[10] ftHE: 24VDC (11V-30V), 80mA (24V DC)

[11] TAERIEILEE: -20°C ~ 60°C, AHNHGE 5% ~ 95% (TGt

[12] #MEJSF: 1156mm (K) <100mm (58) ><18mm (i)

[13] Z%%: 35mm THh

[14] iy 4554%: 1P20

1.4 HESRAMR
1.4.1 BEFTFHRE ( GB/T15153.1 classIll )

CEM PN LG
it i3z i CEM PN S|
ik NI ]
551 PR 2.5~3kV
RS 1.0~1.5MHz
N 1/2 % Pt (1] >6us
AT 50 [FIEA F/s
TR0 1% g BT 150~200Q

1.4.2 PRI BFER Bk i A ( GB/T17626.4 classIIl )

FLYRA A TS T IR 2kV
i 59 1kV
R 5 kHz

1.4.3 BB B TI0( GB/T 17626.2 classlIl )

P T H e HY N A Sy
HiH . HLU 6KV FAMEE, BRI AR IR T 22.5A
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RE R4k 1 P LA L Al BE 10 [RILL
W IEM

1.4.4 55T EREZ ( GBIT 17626.3 classlll )

LY AR 150MHz, 400MHz, 900MHz
X300 10 V/m
AR T AT A5 R 2 iy i FR Al 2, B A ity 1, T 452 S L
1.5 MR
PN/ D QR KT

PM-160, PM-125, PM-126 %
SR UL LR = S Ui B, 357 ) 2 F) s wwwisibotech.net, BRFFRFTH AR L Hi#4k: 021-5102 8348

16 K&
PROFIBUS DP: PROFIBUS DP i3

RS485: — i LI REH RV
PM-127: Modbus(RS485)/PROFIBUS DP [ 3%
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2.1 FEEmA R

User Manual

TBINSE T

PROFIBUS DP #f

L

RS DA S
PROFIBUS DP
B
2.2 /AT
STA AT TN PROFIBUS DP st 2k 5 £l
(PROFIBUS DP MR &850 SEET K bGP LK
PBF ARINpA PROFIBUS DP Jat 2k S 45 15 I
(PROFIBUS DP M4 IRATRZNET) ARIPS B A5 1
RX SEAT IN R RO B
CHTRIRESHRZRST) EIAPR SIRP R e
TX 2R kT IR R E A H
CHTPIRSHRZRTD LA K TGRS
- 5 -
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2.3 RIBIFXR

PROFIBUS DP 1k & fith T < it ' 15 1 =

(LT

On 3

1

6

RPN S
1-7 £7. PROFIBUS it g = FHAK 3 iy —2EHiIZwAS (On b 1, Off 24 0).
R EETBE “7” A28 PROFIBUS Hiib B m AL (Addr bit=6), % “1” A7k PROFIBUS #uilit B &AL (Addr
bit=0). sk M BUEIE A T ZEHEFU I .
S )RLTFRIVER . B O IS V3.0. V2.0 = hilAS; B 1 INSEE V3.1 77 SR
B “17, “37, “B” Aoy lik#| “On”, JLEHRA “Off”, W s PROFIBUS DP ittty “217, H.
PR A V3.0 LU V2.0 P75 AR .

2.4 BiEuwH
2.4.1 HLYBEES N RS-485 ¥g
(1)HEFEEO

1 GND
2 NC
3 24V+

Bl Thek

1 GND, Hisiih
2 NC, Toik#:

3 24V+, HIRIE 24V
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(2)RS-485 2|

1 D+
2 D-
’ GND

El): ke
1 D+, EHH %% RS-485 £+
D-, & P ks RS-485 -
GND

PM-127 7= }h[r1485 32 1 JEbrHEfIRS-485 #2110, LU R A " HIRS-485 k.

& RS-485 fEfHoRTARFAE
@ WgsIhih: VR, Pl I B 2 2 i Hi i ;

@ fEfEZ: 1200 bit/s~115.2Kbit/s;

@ Srpi: BrOWS g, WU, BT IS (EMC);

@ whipif: RErBL32 AUl (O, A2 R 127 Ak GiEPgk);

® kiER:: 3 Al 1

€& RS-485 B £ A 1

@© AFBE %I RS-485 k%R

@ RERMRIE A — AR P, 120Q 12W RN 45 0] 51217
AT LR A TFRR 3 B r R -, FH P R AR AR B R s A T He 2k
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2.4.2 PROFIBUS DP flﬁlzl

it ik : :

- 50.) GND (Pin 5)
PROFI_A (Pin 8) o ° .
o PROFI_B (Pin 3)
o)
o ©
10

O

PROFIBUS DP Ik JHl DBO LAk, | e S F

511 (R

PROFI_B, ik (b4
RTS

GND

+5V Kt

PROFI_A, kst (a8
LY SHIELD, &2k igiht iicth
I PROFI_B (511 3). PROFI_A (5111 8) Fiptiici A ads: RTS (51 4) v LA — e 25 ok vl e A& 4
Jill; +5V (51 6) F1GND (511 5) F Tk, Wnr LU GEFBUR A b, 515 71 6 s Kt
Wl 80MA.

| o o] ] W
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3 PRENHTER

PUN LA RERT LD B HI 45 1K) PM-127

1.
2.

N o o &

45 PM-127 bHL, 3RBEORUEN]T 2.3 BT U] #CE PM-127 ¥ PROFIBUS DP Hidik.
1 GSD C1E S A E# () PROFIBUS 4L A EF, PM-127 15 Modbus = 35 RS ) GSD SCHEANT
AR T 2 N IR GSD 3.
7t PROFIBUS 41&# M4, 1 & PROFIBUS DP Mulifuhils R4 % 1) 75 2200 & Modbus 3B RS H K . 5
i, RLKE PM-127 AH R IR A\ H B 31 PLC 83 PROFIBUS F-ub e & (M N A7 .
HRE: R4l PM-127 /£5 Modbus Eubiy, #7752 ST, WIFFH “Control Module” 412531
BHARY AT, AT LT, WAL “Control Module” BT,
PR 5 RS-485 i (Ui B, OGP S, IERAZERE 3 Bl 7 I BRI TRIAH B 448
FZ [ 5 PROFIBUS DP i B, IE#fER:Z /D 3 71 8 PG
#HEUT Modbus 15 # 1 PROFIBUS DP il {2k, 45 PM-127 I, HEANIE# IR,
) PROFIBUS DP i IEH, ATH THd5Dife, FH P % “Control Module” FRIANALE 1 K fLVF
Modbus i35 iy 2 IR 1% .
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4 PROFIBUS DP X3t AASRAmSHEE
4.1 Z2H B

7t PROFIBUS DP F:ufidlAs At i S BB 24 tids: PROFIBUS DP Mufij& 24, Modbus 4
Module Z#{.

PROFIBUS DP Mufi & Z 8t Modbus JHIRECRF R IS4, SR NI [] L 0 1) 4 IR I ) DL &%
Modbus Mkl CARSEEE RO .

Modbus 74 Module Z%: 4% Modbus 3}, Modbus 74 Module 0t 45: Mubiihl. ThEER .
e an ik LS HE AN

4.2 SEEELE
4.2.1 BIEH TE

?""3
1. 4TJF SIMATIC Manager L& | 41 1.

R SINATIC Nanager
File PLC Uiew [pticns Nindew Help

Dle(pe] =] = w2

% 1

2. s File->New, Hrgt—NTHE, Wikl 2:
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4 SIRATIC Nanager

Fila TIC View Opiiims

ndue 161

v

D|u8%=| %] =

fzer projects | Librariox|

T B:SSicnans\Step?\STprei\Tn

Haye
[T e

Storage Location (path)”
JE 1S manxSapih5Tpra )

]

K2
3. Insert->Station->SIMATIC 300 Station., %1% 3:

T_EODRTS

Dl(EE] - [ele] e [= %) 2l ] o] [ mes =% e K]
IEJ?T_ BODEDS — E:ZvSiemenzis T

EtapThs
WET

vi

=

TproiiT_modbns

[ STWATIC 3M001)
[E STMATIC 3nniil

Kl 3
4. X SIMATIC 300(1)->Hardware, #JFF S7PLC Ai{F41A 5w, Wik 4:
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-/ SINATIC Nanager - T_NODBUS

File Edit Inssrt TLC Yiew Options faindor IHelp

D27 %|m|e| bl [o 2] o) sl &) < rawe ;_[Eggjg_ji?_”

‘li:i} T_HODBUS E:\Siecmens\StepT\S5Tproj\T_modbus

=& T_MCDEUS
55 STNATTC 300012

K 4
5. H@éﬂ%&ﬁﬁﬁn@ 5 Fﬁm, M GSD SCF 2 i A% ISP 2 T TRE A 1.

5. 0¥ Comfig [SINATIC 30 “onfiguration) T_BODBIS]

BC ¥ =lrx]

D#I%I“ _I _—-IEI _I_I_I_J_I

=l Irsfi [Standerd =]
H E EROPIAIE TIF

= BB STMATIC 30

= i STHATIC 40

= Bl STMATIC FC Baxed Centrcl 30004
B STHATIC BT Siadion

oy

Listrituiad rucxl

Fress L te gt Help.

K 5
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4.2.2 VEM GSD XAF

PM-127 {24 Modbus F=3fi FIA SIS (1) GSD SCAHAR], AR 77 28 3 AN IEMHY GSD S 4144
FEamASE *.gsd SCAEEHIFILL T 4E:  Program files\Siemens\S7tmp\PM-127
1. B 5 hoCH Y Er TSR )5, sidisEfs Options->Install GSD file, 4[4 6:

mIn

X HY Config: Configuring hardware

Station PLC View HOJSESH

J Do 2~ H By Customize. .. Ctr1+A1t+E
in

Edit Catalog Profile
Update Catalog

Install H¥ Updates ...
Install GSD File. ..

Find in Service & Support...

Create GSD file for I-Device

Kl 6
2. BN 7 Frond I, %% SIBO1272.9sd Bi# SIBO1273.gsd, fidi“Install”, EMTEE, H#di“Close”,
K A 1
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Install G5D Files

Install GED Files: from the directory ﬂ
||: MProgram Files'Siemenz'StepThSTtmphEM-12T i HBrowse ... i |
File | Releaze | Verszion | Languages |
SIBO12TZ. g=d  —- - Default
ZIB01273. gsd  —— - Default
| Show Log Select ALl Deselect All
Clase Help

7
3. {EHALTEFE Options->Update Catalog, 7F Device H 3% 55 FTvE MO &, #0] LAAE A%
/PROFIBUS DP/Additional Field Devices/Converter/$% 2| % v M 17 %, WKl 8 Fis:
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= G@ EMZT Modbuz Master V3.1
Iniwer=zal module

Status (8 Commands)
Status (16 Commands)
Status (24 Commands)
Status (32 Commands)
Status (40 Commands)
Status (48 Commands)
Exception Codes

Read 1-8 Bits (D)
Read 9-16 Bits (D)
Read 17-24 Bits (Do)
Read 25-32 Bits (Do)
Read 33-40 Bits (D)
Read 41-48 Bits (Do)
Read 49-56 Bits (D)
Read 5T-64 Bits (Do)
Read B5—TZ Bits (Do)
Read T3-80 Bits (D)
Fead 81-88 Bits (Do)
Fead 89-96 Bits (Do)
Fead 97-104 Bits (Daoex)
Read 105-112 Bits (o)
Read 113-120 Bits (o)
Read 121-128 Bits (Dacaix)
Read 129-136 Bits (o)
Read 137-144 Bits (Do)
Read 145-152 Bits (o)
Read 153-160 Bits ()
Fead 161-168 Bits (aacax)
Read 169-176 Bits ()
Read 177-184 Bits (cxx)
Read 185-192 Bits (xx)
Read 193-200 Bits (cxx)
Read 201-208 Bits (acxx)
Read 209-216 Bits (cxx)
Read 21T-224 Bits (Dcxx)
Read 225-232 Bits (Macxx)
Raad 233=74MN Rit o M’

K 8

423 HBEE

1. FIOFE e TR A B E Ui, W PLC rack, XLifi“Hardware Catalog\SIMATIC 300\RACK-300\Rail”,
Wik 9 fror:
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[.THY Config — [SINATIC 300(1} (Configuration) —— T_NODBUS]

e
“Etation Edit Inzert FLC Yiew UOptions Windev Help =Ii|£|

D|E-2 %) & dnlaln| D % w2|

R | Profi IStandard ;I

[ 3 PROFTEUS D
=-{8 SIMATIC 300
f#-(Z] cP-300
=7 cPU-300
(-3 CPU 312 IFM
- CFU 313
Address: m If a subnet iz selected, D CEU 314
the next available address is D CEU 314 IFM
i [+ CPU 315
=13 CPU 315-2 TP
BEST 315-2AFO0-0ABO0
BEST 315-2AFO1-0AB0
BEET 315-2AFO02-0AED
{1 BEST 315-2AF03-0AB0
BEST 315-2AFS2-0AB0
(] BEST 315-2AFS3-0AB0
[+ CPVU 316
-0 CRU 316-2 TP
[+-{] CRU 318-2
[+ CPU B14
[+ CFU T
#-(Z] m-300
-3 M-300
E R | #ERh | - WT-EXTERSION
w1 Fs-300

Properties — PROFIBUS interface DP NMaster (RO/52.1) |£

[

General FParameters I

Subnet:

Hew. ..

Properties. .. |
Telete |

£ | 11} ] 3|

m w -2 m-300

[+ SIMATIC 400

[]-- SIMATIC FC Based Comtrol 30074
=48, SIMATIC FC Station

S0 Hodule ... | Drder rumber ... | BFI addressz | T add... § addrezz | Conment

T =

i. 1L}

|
BEST 315-2AFO0-0AED A
48 BB work memory; 0.3 nsf =]
1000 instructions; MFI + IF —
conmections; for multi-lier

B

|| e oofra]—

|

Presz Fl to get Help. | Chg

K9
2. BOE CPU MEBR, SEFORT I BE A SR AAN P 7 AT R A 5

3. filid PROFIBUS DP %%, ¥ PROFIBUS DP: New->Network settings, i%#¢ DP, i&#&—ANBdsZan
187.5Kbps, #RJ5 “OK”, Widi't:: & 10:
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“;-H' Config — [SINATIC J00{1) (Configurstion) —— T_RODBUS]

g;i'..l‘.;. Bdit Iaxery JIC Vize QOptions findos Nel & X

DIZE %) 8] ~ie] k) =6 B )

2 Brei [Stadwd >l

& B PROETRIS 17
- |= [l sTwTIC 300
r@a
= () craon
= = Qo
# Jcru3iz
# o cew s
* 2 CBY 314
#1 ] CFY 314 1M
# e as
= 2 Ce¥ 315-2 DOP
38ST 315-2AF00-0AZ0
SEST 315-2A¥01-0A20
3BST 31S-24F07-0AFD
¥ () 5857 315-2AF0Z-0ME0
SEST 315-2ANB2-0A20
# ) S8ST 315-2AF83-0X30
# 2 cev 318
+ ) CPU 3162 OF
# O cry aie-2
* ] CBU B4
* O cev e
Lm0
& ) =30
@ (] M-EXTIRSION

__we |
| Brofila: + [ rs-300

P 1 -3
a;:f;ﬁl RS ius Paraveters. j = RACK 200
Wsar-Defined B fait

o W + ) =20

q i+ [ simrIc <0
sl woe ... | Order nanber & [{] STMTIC B Based Control 300/

e I o I P ]u:ﬂ,smmmsmi..
< 13

[E257 315-2A¥00-0kB3
4B ¥E werk nemory; 0.3 ag/
1000 instructiors; MPI ¢ DP
|ceanecticax. for aulti-tier o

Properties — PROFIBUS intexface DP Nazter (RO/S52.1)

General Foaranetors I

s !2 vl If u subnet ix selected,
A Ahe ment available address i3

Propertics - HNew subnetPROFIEDS

Ganarsl Fetvork Settings |

0 or

- Iranxaixsion Bate:

2
ha’

=

ol alclrof—-

I

Press Fl to get Melp. [

K 10
4. %FF PROFIBUS Master station Huhil, 1% 11:
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JIH¥ Config — [SINATIC 300(1) (Configuration) —— T_NODEUSI
B ztotion Edit Insert FIC View Options Window Help == x|
D[[#~(W W) & oo slsa] S[ED % w2l
- Erofi IStmdm’d LI
[E38 FROFIES IF
Select Profibus Address = [} sTMATTE 300
[
) _ ) [+ (I CP-200
Properties PEOFIEBOS interface DP Naster _ I:Iu CPU-300
General TFaramators | ¢ E-L) CRU 31Z IFM
[A I e
edr e E =l HE o ot e oiloetod) o o aid
the nemt available address is © @ (I3 cey 31 1Em
Highest addreszsz:1Z6 . | g v as

=[] cFU 315~ TF
[@] 6EST 315-2AF00-0ARO
|TI BEST 315-2AF01-0ABD
o [E] sEsT s15-zarme-0aED
(] BEST 315-ZAFO3-0AB0
By 6EST 315-2AFO2-0AROD
[ BEST 315-2AFA3-0KR0
R T T
 #-{) CPU 318-2 DP
@] CFU B18-2
e[ CRU R4
¢ cPu T
| [0 Fm-zo0
© @D h-z00
HE ] Fifh | ¢ () WT-EXTEHSTOR
(L Ps-a0n
(= (2 RACE-300
Pl Bail
@] sm-z00
| G-{l] STMATIC 400
[+ B8 STMATIC PC Based Contrel 30074
[+ 3, SIMATIC PU Station

Trancmiscion rate 18T.5 kbit/e

Subnet !

FROFIEUS (1]

Froperties...
Dalate

=

3

|J\
|

)  UR

S... E Modul e ... | Order number ... | MPL address | I add .. O addresz | Comment

T |13

4 i

L] | &8
BEST 315-7AFO0-0ARO ~ EI
48 BB work menory: 0.3 ms/

1000 instructions: MPT + DF

| lconnections; for multi-tier .

||| e wra)l -
|

‘agz F1 to get Halp. [ o
11
K5 3t PM-127 BC A 2 PROFIBUS RIZ$HCE 2, IR A b 2ot ey 31 S7-300 B He 1 43 1
WAEZ T, il 12:
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[XH¥ Config — [SINATIC 300 Station (Configuration) —— PE-160-315] ]
il 5o Inzert FIC Yiew Optiens Hindow Help -8 x

D&sW W& L i == O

~ aixl
1 FS 307 SA | LT
z CFV 315-2 DF Erofil [Standard |
f L I PROFTBUS (1) TP master system (1) = B PM2T Madbus Master V2.2 A
Y P Universal module 1
5 ) Statuz (8 Commands)
5 Status (16 Conmands
T - Status (24 Cor
& N Py A *jJ Status (32 Cor
: By B s Pt 5 S F
10 B Status (48 Cor
. B 2R U5 R E
Read 1-8 Bits Oxxxx)
Read 816 Bits (Omax)
Rea i
Real
Fea
Real
\ Read 48-56 Bi ts (hoooe)
Read 57-64 Bits (Dxxoc)
Read B5-T2 Bits (Dxxoc)
Rea )
Rea sc)
Rea sc)
Read 97-104 Bits (Oxxsex
Read 105-112 Bits (Dxxex)
Read 113-120 Bit= (Oxerx)
Read 1217126 Bits Dmerx)
Read 129-136 Bits Dmexx)
Kead 137-144 Bits Omex)
Kead 1457152 Bi ts Mmex)
Read 153-160 Bi ts Do)
< Read 161-166 Bi ts Do)
Read 163-176 Bi ts Do)
:I:I (15)  PMIZT Modbus Mester V2.2 Read 177-184 Bi ts Do)
s P 1D Order Funber / Designation | I Add 0 Address i:: 12:,;?5 z;t I::;
i 20 Read 33-40 Bi ts (Dwsexx) 0.4 ~ ead Z01-206 Bi ts (oee)
E El Read 208-216 Bi ts Miomx)
2 Read Z17-224 Bits (Dwoux)
3 Read 225-232 Bits (Dwouxc)
; Read 233-240 Bits (Dwcuxc) 3
z 5
8 te
Press F1 to get Help Che

12
BAER Y B, S8 PM-127 Ebx (PM-127 Modbus Master V3.1 5% PM-127 Modbus Slave V3.0) i %
e LT M ECE Y, Hi3] PROFIBUS DP 2k b, BFRSBIIER, FORTLURN T o 28 0 @ ¥ Azl
AR edti sh 2 42 R 7 Bym st R ms of, RS AR AR, DA AT URON 3 B S e 1) PLC A7
HER: PROFIBUS DP Ml bk 2 5 4 i) e i — 3 !
6. W H PROFIBUS DP MiliJ& 240 L4 Modbus #ir4 Module 44, 152% 5.2.4 %11, A7 FEE
PLC.

424 BB

SR EZ R, BAIFET# PM-127 Modbus Master V3.1, PM-127 Modbus Slave V3.0 & HAE N
PROFIBUS DP Mufiff @2 H L K % H T SCRe R AN R Module FIZ 4
B PM-127 Modbus Master

M€ PM127M22.gsd SCAFJ 5 E H s il #2244 BRI e, 2 1 PM-127 ££ Modbus #ifF: 4 Modbus
Tk,

< PROFIBUS DP M@ S5

www.sibotech.net " 19- Sibo TeCh®



PM-127
Modbus (RS-485) / PROFIBUS DP [ X
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EHAFI, Xl O Hizh %] PROFIBUS DP M4% ) PM-127 Modbus Master V3.1, # i@t St ian -

SV

Properties — DF =slave b_(|

General [arameter As=zignment l

Parameters Walue
-5 Station parameters
- Device-specific parameters
[£] Bandrate (bps) QE00
ata bits, Farity bit, Stop bits ane
i} b1 FPari bi ) bi =1 1
E] Frotocal Type Modbus Master
exponze Timeout ms
E R T 300
elay Between Folls o Delay
Delay B Foll Ho Del
] RTT
-5 Hex parameter azsigmment
] Vser_Prm Data (@ to 7) 00, 00, 00, 40, 00, 03, 00, 00
[Z] V=zer_Frm_Data (5] a0

CIEWdiE GOk

Baudrate (bps): it & H HJ4F%, 300, 600, 1200, 2400. 4800, 9600, 19200. 38400. 57600, 115200bps
Cipvit

Data bits, Parity bit, Stop bits: Bt E A7 55077 X L L& A7 1147, 8 None 1. 8 Odd 1. 8 Even 1. 8 Mark
1. 8Space 1. 8 None 2 mJik;

Protocol Type: 4#{i%] PROFIBUS DP &4k /& PM-127 Modbus Master, 1% 4 “Modbus Master”;
¥z %) PROFIBUS DP 2k L [1/& PM-127 Modbus Slave, %54 “Modbus Slave”;

Response Timeout: 4 Protocol Type A& Modbus Master i 45 %%, 100. 200. 300. 400. 500. 600. 700,
800. 900. 1000. 1500. 2000. 3000. 4000. 5000ms W] i%;

Delay Between Polls: 4 Protocol Type 4 Modbus Master i 5%, No Delay. 50, 100. 150. 200. 300.
400, 500. 600. 700. 800. 900. 1000. 1500. 2000ms J % ;

Transmission Mode: % Modbus i ifl#, RTU. ASCII n]ik;
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<  Module 2%

TR, A CHEs) 3] PM-127 XA R 72k 1) Module, 55 H ¥ P S W R B TR

Properties — DP slave @

Address f ID FParameter Assigmment ]
_Parameters | Value
= r‘jStat:on parameters
= ljl]ewce-speu fic parameters
} Ej Slave Address 1
\-[£] Function 15
E::] Starting Address 40
g Ho. of FPoints g
BB ]Fi=x poraneter sssig
Concel | Mol
AECE S HAES

Slave Address: & & PM-127 Jir223&42 1) Modbus Mk Hilik, 1~247 Wik,

Function: Joifi BE, ZhRERSA - AN Module;

Starting Address: ¥ E A7 A7 av i Hidil, 0~65535 HJ ik

No. of Points: #5140, 47 01H. 02H. OFH IhAEMAE (1) Module 17 B2 B 5d A 41

<& X#H Modbus #r4 Module

PM-127 {E°4 Modbus Master i+ 32§ (1) Module fi4f: Control Module . Status Module. Read Module. Write
Module

Control Module: Control (8 Commands)~Control (48 Commands)

YE% Modbus ufi, ] Al AE PROFIBUS mfZ i Modbus 4 ) 3%, $24t 6 25421 Module L+,
A PM-127 HBEHICE 1 447 Module.

i EAFELES Modbus i<, NIAHZEAES] Module, Modbus fir¢< BHEJRIE.

Control (8 Commands)~Control (48 Commands): 6 i 1, #HIELEEAMT (bit) #2414 Modbus fiv4>,
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User Manual

TEATRE (i 24RO BTN (bit) B 1, AFHELREN & 0;
a) Control(8 Commands); f5#i]i%i% Control Module T 7EAS A7 2 S5 8 efir & A%, TR HIX 147

-

Hs

b) Control (16 Commands)

T

¢) Control (24 Commands)

A,

d) Control (32 Commands)

A,

e) Control (40 Commands)

T

f)  Control (48commands)

T

: 2% Control Module FTERIA; 2 51 16 5 S RIAIX,

: $iili% Control Module T EREAT 2 J5 1) 24 4 2 1K,

: $4ili% Control Module T 7EREAT 2 J5 1) 32 4 2 1K,

: $4ili% Control Module T 7EREAT 2 J5 1) 40 4 2 1K,

: $2HiZ Control Module FTZERENL 2 5T 48 Sktim 2R I%,

b A X2 A

AT X 3 A

AT 4 A

o T H X 5 A

b g X6 A

R HPERIERRE, FRERIREINE Read Module P& Write Module FrEt#AL

FRIRITH -
i -

WIS P AR SRR AT S R 7 L 7 45 A (7 N B AR PO, W) n] 1k £e4 i1 H“ Control (8 Commands) ”,
Wt & EHE I Control Module #ill (1) iy 2 4 B0 EE N T8 &5 T IC B a2 4 20
ficin PROFIBUS DP = sl f A7 v (1 £l Bl R i 7

:I:I (== FM1I2T Modbus Master V3.1

Slat IF I... | Order Humber / Desigznation I Add. .. [ Address
1] 129 Control (B Commands) (]
1 801 Read 1-8 Bits (Dxxxx) ]
2 801 Read 1-8 Bits (laxaxxx) 1
3 aaT Read 8 Words () S12. .. 52T
4 aaT Read 8 Words (Gwrx) 9z, . 60T
5 210 Write 1-8 Bits (Dxxxx) 1
] aa0 Write 8 Words (daex) Gl2. .. 52T
T 231 Write 8 Words (daxxx) Consistend 9z, . 60T

W 5¢ FHL S, B4 PROFIBUS DP i

z3d

Write 18 Words (dxxxx) Consister

THIES (STA SRATINER ). SR, F P 35845 4 i kil QBO it fE K

e T2 & I 2o a5 T REBC B iy 2 TP K26 2 (Read 1-8bits (1xxxx)) A% 4 4% (Read 8 Words (3xxxx))

2
>

www.sibotech.net
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1001),

Status Module: Status(8 Commands)~ Status(48 Commands). Exception Codes

YE24 Modbus 3, PROFIBUS i 1] A #H Modbus it 2 [FPARZS,  $245# Rl Modbus 4 IRZS AL D) e -

Status(8 Commands)~ Status(48 Commands): 6 i% 1, AN 732744 Modbus fiv 2 IR AS, Wi I
B, WNRE RN B BOA B 3 R, T R R A IR

a) Status(8 Commands): Wit 8 &fnd

b) Status(16 Commands): Wi#H 16 &4

c) Status(24 Commands): Wi#H 24 &4

d) Status(32 Commands): Hi#f 32 &4

e) Status(40 Commands): Hi#F 40 &4

f)  Status(48 Commands): Wil 48 &4

Exception Codes: 4 1word Module, #7537~ Modbus fir 42251 0 ~ 47; K735 2 7 5 A oAt 21 .
M N A ISR DA A O M N R B IN R IN A T e AL AL, AR FNBER, e Y I
BRI R RS OXFF.

Read Module: Read 1-8 Bits (0xxxx) ~Read 249-256 Bits (Oxxxx). Read 1-8 Bits (1xxxx) ~Read 249-256
Bits (1xxxx). Read 1 Words (4xxxx) ~Read 64 Words (4xxxx). Read 2 Words (4xxxx) Consistent~Read 16
Words (4xxxx) Consistent. Read 1 Words (3xxxx) ~Read 64 Words (3xxxx). Read 2 Words (3xxxx) Consistent~
Read 16 Words (3xxxx) Consistent

YE24 Modbus T3k, ZHFf Modbus 244 Module W1 Tk, 7 nfiR4s 75 24 ) A [ 1¥) Module J-13E47
i B AR S B BRI AT

Write Module: Write Single Bits (Oxxxx) ~Write 249-256 Bits (0xxxx). Write Single Words (4xxxx) ~
Write 64 Words (4xxxx). Write 2 Words (4xxxx) Consistent~Write 16 Words (4xxxx) Consistent

1§24 Modbus =3k, ZFE1 Modbus 5 fiy4 Module 41 FATE, P TR 5 24680 AN [ 1) Module F-3E17
fia] B AR S BRI AT

B PM-127 Modbus Slave

M 5E PM127S22.95d SCIF ), 78 H s n] 4R BNZ A BRI 5%, i 13 PM-127 7 Modbus %iiff: 4 Modbus
M o

<~ PROFIBUS DP Mt/ HS%.

PEAA T, Ak D Es)#] PROFIBUS DP (4% (1) PM-127 Modbus Slave V3.0, 4t Hi 1) J& 4 Fit i i F 1&]
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PR

Fropertiez — DP =lave FE

General [arameter As=zignment l

Parameters Walue
-5 Station parameters
= a Dewice—specific parameters

[£] Bandrate (bps) QE00
E] Data bits, Farity bit, Stop bits |5 Hone 1
E] Frotocal Type Modbus Slave
[£] Slave Address 1
[Z] RTU

¥ D Hex parameter assignment

CIEWdiE GOk

Baudrate (bps): At & H HJ4F%, 300, 600, 1200, 2400. 4800, 9600, 19200. 38400, 57600, 115200bps
CIpv¥

Data bits, Parity bit, Stop bits: Bt E A A7 #5077 XL L& AF 1147, 8 None 1. 8 Odd 1. 8 Even 1. 8 Mark
1. 8 Space 1. 8 None 2 WJi%k;

Protocol Type: *4#:5)%| PROFIBUS DP &4k I [1) /& PM-127 Modbus Master, 1% 4 “Modbus Master”;
¥z %] PROFIBUS DP 2k L [1/& PM-127 Modbus Slave, %54 “Modbus Slave”;

Slave Address: 4 Protocol Type >4 Modbus Slave B 5%k,  &'# PM-127 {£% Modbus M3k (i, 1~
247 Wik,

Transmission Mode: % Modbus i ifl#5, RTU. ASCII n]ik;

< Module 2%
TEAZS T, Xl CHEB R PM-127 %R 125 R 5 8 1 Module, 50 1) J& P 5 i R B s
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Properties — DP slave @

Address f ID FParameter Assigmment l

Parameters | Value.
=|£§ Station parameters l
=HA ar 8
E:'j Function 3, B, 18
i+ Hex parameter assignment

Cancel I Help I

Hr: Function: 44z %:— Module i, Function U252, #F7~i% Module S £§(¥) Function 45
03H (3). 06H (6). 10H (16),
< ZFM Modbus %4 Module
PM-127 1£>4 Modbus Slave I 32 £ ¥ Module f2.45: Status Module. Input Module. Output Module
Status Module: Status
124 Modbus M3, PROFIBUS i 1] LA i # Modbus W41k 25 , PROFIBUS i £2 1 Modbus [ 41k 4 Module,
AN, AR SR IR RIS, RS
Input Module: 8 Bits Input (Oxxxx) ~128 Bits Input (Oxxxx). 1 Word Input (4xxxx) ~64 Words Input

(4xxxx)~ 2 Words Input (4xxxx) Consistent~16 Words Input (4xxxx) Consistent
£ Modbus Mk, SZHF) Modbus 24 Module 1 FJTik, FH 7 AT A4 #5224 30 A [F] (¥ Module £ T
i AR S BB R AT
Output Module: 8 Bits Input (1xxxx) ~128 Bits Input (1xxxx). 1 Word Input (3xxxx) ~64 Words Input
(3xxxx)~ 2 Words Input (3xxxx) Consistent~16 Words Input (3xxxx) Consistent
1§24 Modbus Miti, SCHFR) Modbus 5 fir4 Module 4n EJrk, JI P IR #5 £ 30 AN R 1K) Module Jf-3E4T
(L &P an P

www.sibotech.net "2 Sibo TeCh®



PM-127
Modbus (RS-485) / PROFIBUS DP [ X

User Manual | B

5 Modbus F. M5 TEREH
5.1 Modbus FE i T {ERIE

PM-127 Modbus Master () Modbus F! PROFIBUS . [f] [ 4 i 4 8 ok Wi 58 Rk e 57 75 PM-127 45
PAPEARZZ P X, — Bt PROFIBUS MIZE A ZZPIX, 5Bt PROFIBUS 2441 2z 1X . Modbus 325X
AN U B0 B NS I 45 5 N2 b X, it PROFIBUS 2% 521X . Modbus 5 25 17 252 1 i 4 M 04 2 it 2
PR, 8 S a4 H 2R YY) Modbus 3£ .

NG gz rhX
8
> —T—| Modbus
Modbus > W1
W 1
~
Modbus >\‘ Modbus
el w1
”

SZFF 01H. 02H. 03H. 04H. 05H. 06H. OFH. 10H 5 IZhEers, /AT LLAC & 48 £ Modbus %> Module.

5.2 Modbus Mt T{ERIE

PM-127 Modbus Slave [ Modbus F1 PROFIBUS 2 [a] i 4# e 4idi ik “ B SCHR RN 78 PM-127
APHEARZ X, —PuUE PROFIBUS BIZHIA 0TI, J—3uUt PROFIBUS Mgt Zzix . M4
N 22 b X HB M0 T PROFIBUS 1M 5 1. Modbus 5 27 47 2% 25 v A Bt 5 N 2 464 N b X, it
PROFIBUS M £% 1. Modbus 151 ir - A 194 28 i H 22 b DX IUEcH , - 3 mi AR S A% 44y Modbus 20l B4
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Modbus G4 :

06H £1 10H

Modbus liﬁ/?\

03H

00000 (40001)

00000 (30001)

User Manual | B
PROFIBUS PROFIBUS
i NZE P IX 2B PP X
AXXXX 3XXXX

00001 (40002)

00001 (30002)

00002 (40003)

00002 (30003)

Modbus i 4>
04H

OXXXX

IXXXX

Modbus E iy 4

05H F1 OFH

Modbus 4

01H

00000 (00001)

00000 (10001)

00001 (00002)

00001 (10002)>

00002 (00003)

00002 (10003)

Modbus i 4
02H

W Modbus ZFfERSHIIE 3 X (3xxxx)s 4 X (4xxxx)~ 0 X (Oxxxx) Al 1X (Ixxxx); Hrdr, 3 X LH:
DIfetts 04H; 4 XICREDIRERS 03H. 06H. 10H; 0 X S FFUjHERS 01H. 05H. OFH: 1 X RFUIfigfidh 02H:;
PROFIBUS DP i NZE X %1 Modbus —fill, /& Modbus Eufifiiiti, WTE] Modbus PREF2F£788 4xxxx
(ffi ] 10H H1 06H fir &5 A% dhs, A 03H fir & [l it ) L8 Oxxxx C(ffJT] OFH A1 05H fir & 5 A\ H 4l
T O1H i 4 [ .
PROFIBUS DP #i ! 22 b [X %} T Modbus —{lf, /& Modbus =3b%i A , 5} 3] Modbus % A\ 27478 3xxxx (i
FH 04H i A BCE R ) A AT Ixxxx (fi T 02H iy A S B D -
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6 Step7 WA LS B

PM-127 124 Modbus Master 25K 5 56 %) Modbus 74 Module 41~ fiT7xs:

Read 2 Words (4xxxx) Consistent~Read 16 Words (4xxxx) Consistent. Read 2 Words (3xxxx) Consistent~
Read 16 Words (3xxxx) Consistent. Write 2 Words (4xxxx) Consistent~Write16 Words (4xxxx) Consistent

PM-127 1§24 Modbus Slave 32+ K& 5¢ %4 ¥) Modbus 74 Module 1 R s :

2 Words Input (4xxxx) Consistent~16 Words Input (4xxxx) Consistent. 2 Words Output (3xxxx) Consistent~
16 Words Output (3xxxx) Consistent

XA 58 # ) Modbus T4 Module, 7E Step7 4 i 25K T AUk I S FT R Uk0R 5 el 32 2
HI% SFC15 (FTHRI%X) F SFC14 TR

“DPRD_DAT”
—EN EHNO
W#16%#0 LADDE EET_WVAL [-MW50
F#DE100,
DEXD. O

EECOED —EYTE 18

SFC14
“DFWE_DAT"
EN ENO
Wit 16#0 —|LADDR FET VAL [MWEQ
P#DE100.
DEX0. 0
BEYTE 16 —RECORD
SFC15

Sof TR se 2 AR IS Modbus 1iv4 Module, 7E Step7 2 i r) LLE 48 ] MOVE 454 % $di k472
H,
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| B

7 3k
7.1 HUBR

RF: 115mm (KD ><100mm (55) ><18mm ()

100mm

User Manual

Z
jj
",

115mm

7.2 ZHFRITIE

35mm DIN G428

www.sibotech.net
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Y T L R / R775R WAFFRE
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8 BATYEY KIEREM

BB L E s, PRI A o

E82 S NTRE 5 e S e 87 N i€

P U R AR B P I ERVEF Y, DARTRERBEIR .
R I 13k 7K, BEARE W I A
RS E R AR, AT RS A

R R
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9 FRABUE B

AL P S s M BRZFRABUAN T R WU A 767 h I R RE AT e AE AN S L
(Rt DL B X7 AT TSR

SiboTech 2. vt [ 2 HoAR AT B2 7] 0 A o
B VEZ N, A AT BT A D BN G RAT S AN S i 2 el QRsEE T, M,
R FbRE .
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f¥%: Modbus il

Modbus-RTU #3iX:
Y. 5P IR & OO0 Modbus #H, [ 1% £ Modbus WU RAT& NI E, AN w4
FH P RS

ARDISVET5%

W) AR RS485

T 0-247

THRPRF R W

WA R BRI L

et EMCET 5

P FRAM R Bl P & i R G, XGRS — M A iRk L5 S
WM AT e . 126, EUENNGE S U8 — M — &k s (WP, 2RJE, EH 7
b 2 v 2% R N B T AR e B L.

U ARVFAE BT RNV 215 2 2 0], AN SRVPAIOT (9 B 46 2 B AS e, XA S EA e I0Iin
AT o 4l TR, T A PR I Y B A A KL A .

— AN EL RS

1A RRURAT, 8 Argds, 14745 1Ay .

— AN s X
Hihik IR B A
8-Bits 8-Bits N x 8-Bits 16-Bits

PRSP T ARREOAY . B A S, X R R B A (1 A FE N A

M E it B8 St e A4 I, Bl AN R BN SRR R B, 1% b

Bmmi s B CBdinsk), UG, AR, AT BAR TS SRS, RE, e A ORI
PN BN AF A5 B, BB WOR [PIZS Ak . IR A m A B & T LR I iy AMLHBAE
(Address). #EHAT T T4 (Function) . $RAT i 4 A2 1 17 =K £ (Data) Fl— ML K5 (Check) o R AEAT AR £ %
A A BRI Y o

Huhik (Address) 1,

Mol AE W T AR5 4, 1 8 A7 (0~255) 2%, XSS Aril T HH /45 i il 2 i e 4%
bk, xR ERCR A S 2 AHIER BN . RS2 B 2% (P HRE A 200 ME— 1), AN -0k 21 17 2 iy
S AL TS A . 2 A A R —AN I R, 0 A MK L EE B (5 R T LR & 2B S 2
HATIEAS
Iifie (Function) 1%,

DHRESACHE U T 4 Fhk B K im PAT MR ZhRE. R 11 50 T IATRZhRERS . e R S EAIRA)
URTIRE
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* 1-1 Thiem
ME] =X 1T
03 s AN EREATFAFA I A kI
06 THUCE L2 AT A JECE — AR 1) R EME E A P A A A
16 THE 2 247 8% JECE N ) AR — R A2 A A

Ml T LI A TS A D REPT 5 2 ) Bt it 2 i b A I R AR 2 Bl . 35X
SER ) A BT RS BE . S MR E AR R . . D Rei o R i B AN T A, B )
i W AW 27 725 TF00 S 2 DA B, PR T 1 A 5000 A0 B S ORI BT T8 R AN [ e g T A AR T

BRI

I SCVF BN L s S A R B 5. AT, TR AR e T, — 2
PEAE MDA ) — D BRI B BT e R8s, AR SO RES ORAIE T LB 28 3 AN 25
RS LA R b R 2R T BRI, IR R T RGN L MERNNCR, AT T 16 ML LR s
e
[E]  AAEFFSIEGEARF — sihb. ThEehd. HolAnLy oy AR A AL o

B AT I

TEIRTURIE: (CRC) HUE AT, B& T —/ 16 M —HEHIfH. CRC {EHH%

EWAATIRE K, ARG EI B b, Pl SRR N FUE A CRC B, AR5 S 2I CRC 45
HPEET IR, WX AMEAASE, R T H R

CRCIZH I, ¥ 16 MIIZ A28 TE A4 1, ARG ELAER Wb 1) 8 A1
BT S ATEIH TIE &, U151 8 N ERAr 2 5 4B CRC, S AR AL A28 1kA47 LA K ] R4S (1)
FHE AL HA M CRC.

TELER CRC I, AN 8 AT S 3 A7 as P I N AT S8, AR g R A, s A <0 #h 72,
FBARAL (LSB) B AT, WSE 1, X et 5 — i (i i e 8T — I s 5, S sARAh 0,
AMEATAT AL L

IR AT, FEPATIE T 8 IRBALERAE, MEE—fr G 84 BiEllE, T—AN8 i
TALAEM P A E T R Ea &, RIFEET BRI S —A 8 IRFE A7 e lidie A, MBdmmirh P - A T
ABE, AR R R A 2 CRC i .

A CRC IIRAE A «

THE A 16 i1 294728 4 OFFFFH (4 1), FR2Z -k CRC 2 fE8%.
e A 8 7 F 1T 5 CRC Z 74 H IR T R8s 57, 45444710 CRC i fr4%. ¥ CRC % A7
A, EEAIELL 0, BRI H A o
RGN R 0. HEH 0 CF—IRBAD.
WERBARALA 1: K5 CRC Ffras 5 — NI e E (0A001IH) HEAT Rz i .
ARG DREIE HE 8 IR . IXFRACEESE T — /N2 &1 )\ 7.
HIE 2 R 5 R N AN\, EBIPTA ITAb h
% CRC #f7#sfHE M & CRC 1A

2. NHIJZ Zhae v
St LR MR T UM SO EE W, A R P R B3 AT DU 1 3 PR 32 AASE et P80 LE A R e S Al
TIRERE N RERP o
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A F PR BSCRE R AT e A W 2 — 1 Froniisga, (Bevoh 16 D

ik Thuet Bttty (R EEM  [RRNA RENA (BR[O KS
N I b e e I TR e L S e o E I S S = e el
03H 03H 00H 01H 00H 03H 55H E9H

K 2-1 Phislfslik

BE (DhRgR 03)

Y]
K2 -2 B2 A 03 5 MHLEE 3 AN RAE 2 A FE A% U1,U2,U3, UL ikt >4 0001H, U2 F3sik 4 0002H, U3
{1 Hs 41k 4 0003H,
Hohb |DhRERS (ke |REEG  |RERD [BERA (R (RO
01| =i i e [ o o N B TR N € e o I (A ] ISt
03H| O03H 00H 01H 00H 03H 55H E9H
K 2—2 3% Uca F la 2 5 ni
Mg J3,
W AL ML RE . THRERD . 0 18 CRC #5 R 5 .
2 — 3 TR ERE UL, U2,U3 [0
fig mAs |Em [EfR |[Es (EME (Ee (EE (R [
S N S T 2 T e T o T = + I 1S A =7
A0 il il
03H 03H | 0O6H | O1H 7CH 01H| 7DH 01H| 7CH [FOH  [9BH

K 23145 U1,U2,U3 [’ s

2. 2 WMEZ %4y (ThRehd 100

i)

TIRERS 10H SeiF I SR 2 A WA AN, B fTMEATIBIE TR B B i % 16 DRI, e
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